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CORE CURRICULUM
LEGEND DRUGS AND DEVICES
BASIC PROGRAM
40 hours

The 40-hour Basic Program shall include: 8 hours - Pharmacology; 2 hours - Administration
of medications through injection; 16 hours - Treatment of shock; 6 hours - Maternal and
neonatal resuscitation and 8 hours - Suturing.

The chart below is to be used as a guide in the development of your curriculum:

Course / Description Hours Required

PHARMACOLOGY:
Mechanism of Pharmacological Action;
Indications;
Therapeutic Effects;
Side Effects / Adverse Reactions;
Contraindications; and
Incompatibilities / Drug Interactions.
Drug administration including:
Dosage;
Dosage Form and Packaging;
Routes of Administration;
Onset of Action;
Peak Effect; and
Duration of Action.

8 hours

ADMINISTRATION OF MEDICATIONS THROUGH INJECTION:
Universal precautions including the use and disposal of sharps;
Equipment including:

Needles;

Filter Needles (for use with glass ampules);

Syringes;

Skin surface disinfectants; and

Medication containers (ampules, multi- and single- use vials).
Appropriate injection sites;

Procedures for drawing up and administering drugs;

Special case: Administration of Medications Intravenously; and
Care of equipment.

2 hours

TREATMENT OF SHOCK:
Theory of shock;
Non-invasive treatment of shock;
Intravenous fluid therapy;
Purpose of 1V fluid therapy;
Equipment;
Appropriate sites;
Procedure;
Rate of administration; and
Care of equipment.

16 hours




MATERNAL & NEONATAL RESUSCITATION:
e Basic life support techniques;

e Cardio-Pulmonary Resuscitation (CPR); 6 hours
e Use of oxygen; and

e Positive pressure ventilation (bag, valve, mask).

SUTURING:

Define degrees of perineal damage

Explain steps to evaluate genitals for damage postpartum
Explain when perineal damage may not require a repair
Discuss steps to take if a woman refuses repair

List types of perineal damage which requires referral for repair
Explain risks of poorly done repair to women's health

Discuss pros and cons of two forms of local anesthetic

Amide vs. ester based

Discuss use of epinephrine in local anesthetic - pro and con

8 hours

TOTAL HOURS: 40 HOURS

In the course of study the candidate shall receive theory instruction, classroom instructor
demonstrations and/or guided practical experience under the supervision of the authorized
provider. The amounts of time a candidate devotes to theory and practice are flexible
provided the minimum hour requirements listed above are met.




CORE CURRICULUM FOR

PHARMACOLOGY
Objectives Dosage Guidelines Standards for Sources
Instructors

Define a drug Synthetic Oxytocin (Pitocin, Syntocin & | ¢ Oregon Pharmacology
Distinguish "legend drugs and Generic) IM: 10U (1ml), may repeat at Licensed for Midwives by
devices" from other types 2 hour intervals as necessary to Midwife and Jane Poznar,
Explain OAR’s concerning legend | Maintain uterine tone. IV: 10U (1ml) Licensed RPh
drugs and devices including legal | bolus, may add 10-20U (1-2ml) to 1000 Pharmacist Physicians Desk
sanctions for violations ml 1V fluid and infuse at rate necessary (not limited to Reference - 55"
Define and explain the following | to maintain uterine tone Oregon Edition by
o Action and effect Methylergonovine (Methergine) Licensure) Mukesh Mehta

Adverse reactions IM: 0.2 mg (1 ml) repeat if necessary at Drug Topics;

2 to 4 hour intervals Facts and

Agonists and antagonists
Tolerance

Interactions

Placebo effects

¢ Compliance

Discuss various routes of
administration

Explain placental transfer of
medication to the fetus

Explain how a drug moves through
the body

¢ Absorption rate

¢ Metabolism

¢ Excretion

For each of the legend drugs and
devices authorized for use by
LDMs, explain and discuss the
following (see text for specifics)
¢ Mechanism of
pharmacological action
Indications

Therapeutic effects

Side effects/adverse reactions
Contraindications
Incompatibilities/drug
interactions

¢ Administration including
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¢ Dosage
¢ Dosage form and
packaging

¢ Onset of action

¢ Peak effect

+ Duration of action/half-

life

¢ Storage and security
Chart the use of authorized legend
drugs and devices
Devise system for tracking legend
drugs in a home-based midwifery
practice, including expiration dates
Demonstrate use of drug
references

Oral: 0.2 - 0.4 mg (1 to 2 tablets) every 6
to 12 hours for up to 2 to 7 days
Ergonovine (Ergotrate)

Oral: 0.2 - 0.4 mg (1 to 2 tablets) every
6 to 12 hours for up to 2 to 7 days
Misoprostol (Cytotec)

600 mcg (micograms) orally or rectally
for management of postpartum
hemorrhage only

Epinephrine (Adrenalin, EpiPen, and
generic) SQ: 0.2 mg - 0.3 mg of 1:1000
solution (0.2 ml to 0.3 ml) for rescue
from anaphylactic reaction

Vitamin K1 (Phytonadione)(injectable:
AquaMEPTHYTON and generic; oral:
Mephyton; IM: .5 to 1.0 mg at birth:
Oral: 1.25 mg to 2.5 mg (1/4 to 1/2
tablet crushed) at birth, repeating dose
at one week, and at 2-4 weeks.
Menadione (vitamin K3) may NOT be
used

Erythromycin Opthalmic Ointment
0.5% (llotycin, AK-Mycin and generics)

Topically: 1.0 cm (1/2 inch) ribbon in
each lower conjunctiva

Lidocaine (Xylocaine and generic) and
Procaine (Novocain and generic)
Tissue injection or gel for local
anesthesia using the smallest dosage
that will produce desired effects
Topical Anesthetic Spray (e.g.
Cetacaine)

Spray directly to area to be
anesthetized. Do not exceed 2-second
spray duration

Rh Immune Globulin (RhoGAM,
Gamulin Rh, BayRho-D, and others)
IM: 50 mcg( micrograms)
prophylactically at 28 weeks or after
miscarriage up to 12 weeks

IM: 300 mcg (micrograms) postpartum
or after miscarriage beyond 13 weeks.
Sterile Water Papules

Intradermal use as a local anesthetic

Comparisons by
Editorial Board




CORE CURRICULUM FOR

ADMINISTRATION OF MEDICATIONS THROUGH INJECTION

Objectives Dosage Guidelines Standards for Sources
Instructors
Describe and utilize universal ¢ Licensed ¢ Pocket Guide
precautions when administering NONE Midwife to Basic Skills
medications, including ¢ Licensed RN and Procedures
¢ Gloving o Licensed - 4" Edition,
¢ Eye protection Physician - Anne Griffin
¢ Safety equipment MD, DO, ND Perry and
¢ Appropriate disposal of ¢ Certified Patricia A.
sharps Paramedic Potter, 1998
List equipment needed for ¢ Physician ¢ Training
medication administration Assistant Curriculum -
¢ Needles - size(length and OSHA
bore) Bloodborne
# Filter Needles (for use with Pathogens, KH
West, 1992

glass ampules)
& Syringes - sizes, "lever"
locks
¢ Skin surface disinfectants -
alcohol, povidone iodine
¢ Medication containers
¢ Glass ampules
¢ Multidose container
¢ Single use vials
Differentiate subcutaneous,
intramuscular and 1.V.
medication administration sites
List appropriate sites for
medication injection
Explain the "three point check"
technique
1. Date on medication (not
expired), type, dosage
2. Repeat after drawing up
medication
3. Repeat after administering
medication and chart
List steps for administering
drug IM
List steps for administering
drug SQ
Explain appropriate care of
equipment used in
administering medications.




CORE CURRICULUM FOR
TREATMENT OF SHOCK

Objectives Dosage Guidelines Standards for Sources
Instructors
¢ Define Shock IV Fluid Types ¢ Licensed & Practical Skills
¢ ldentify pathophysiology of ¢ 0.9% Saline Solution Midwife Guide for
shock ¢ Lactated Ringers Solution ¢ Licensed RN Midwifery - 3"
+ Listand explain four cellular ¢ DS5LR ¢ Licensed edition, Pam
phases of shock ¢ D5W Physician - Weaver and
¢ List types of shock MD, DO, ND Sharon K.
¢ Explain three stages of shock ¢ Certified Evans, 2001
¢ Describe how to assess a patient Paramedic Advanced
in shock ¢ Physician Emergency
¢ Define "primary survey" Assistant Care by Shirley
and list its three Jones, Al
components Weigel, Roger
¢ Define "secondary survey" White, Norman
and list its two components McSwain and
¢ List two steps to resuscitate a Marty Breiter.
patient in shock Published by
¢ Basic life support : position, Lippincott
warmth, oxygen therapy, CPR w:”('?n’zs and
¢ L.V. fluid therapy :
¢ Reasons for using 1.V. therapy

List necessary equipment for
administration of 1.V. fluids
Explain appropriate care of
equipment used in 1.V,
administration

Explain in detail the appropriate
procedure for administration of
I.V. fluids

Describe appropriate flow rates
for 1.V. administration

Identify s/s of 1.V. failure
(infiltration)

List dangers of inappropriately
placed or maintained 1.V.
Identify appropriate
antihemorrhagic medication
Demonstrate on live model non-
invasive treatment including
appropriate positioning for
shock

Demonstrate, on mannequin,
appropriate steps for
administering an 1.V.
Demonstrate, on live model,
correct administration of an I.V.




CORE CURRICULUM FOR
MATERNAL AND NEONATAL RESUSCITATION

Objectives Dosage Standards for Sources
Guidelines Instructors
Knowledge (cognitive ) ¢ American ¢ Instructor's
¢ Describe the links in the AHA chain of survival, NONE Heart Manual -
inCIUding the importance of Association Basic Life
¢ Activating the appropriate emergency response system CPR Support,
(phoning 911 or other response system) Instructor American
¢ Performing CPR (current); Heart
. Usmg a barrier device o or Association,
¢ Providing bag-mask ventilation .
- Lo ¢ American 2000
¢ Providing early defibrillation of an adult
: : Red Cross ¢ Neonatal
¢ Ensuring the arrival of early advanced care by o
activating the appropriate emergency response system CPR Resusutatlor:h
(phoning 911 or other response system) Instructor Textbook - 4
¢ Describe the steps of CPR (current); Edition,
¢ When to start CPR And American
¢ When to start rescue breathing, including ventilation ¢ American Heart
with a barrier device and bag-mask ventilation (with Heart Association
and without oxygen) Association / and American
¢ How to check for normal breathing or signs of American Academy of
circulation Academy of Pediatrics,
¢ The ABC sequence of CPR Pediatrics 2000
¢ When and how to use an AED on an adult Neonatal
¢ The signs of severe or complete FBAO Resuscitation
¢ How to relieve FBAO in the responsive and Program
unresponsive victim Certified

L

Describe the signs of five major emergencies in adults
¢ Heart attack

¢ Stroke

¢ Cardiac arrest

¢ Respiratory arrest

¢+ FBAO

Describe strategies to prevent sudden infant death
syndrome in infants and injuries in children

Skills (psychomotor)

L

¢

Activation of the emergency response system(phone
911 or other appropriate response system)

Rescue breathing using mouth-to-mouth ventilation ,
mouth-to-barrier device ventilation (with and without
oxygen), and bag-mask ventilation with oxygen for
adult, infant, and child victims

1- and 2- rescuers CPR for adult , infant, and child
victims

Use an AED for victims > 8 years of age (and
approximately 25 KG or more)

Relief of FBAO in the responsive and unresponsive
victim of any age




CORE CURRICULUM FOR

SUTURING

Objectives

Dosage
Guidelines

Standards for
Instructors

Sources

* & & 6 O 0 o

*

* & & o o

Explain basic female genital anatomy

List methods for preventing perineal damage

Define degrees of perineal damage

Explain steps to evaluate genitals for damage postpartum

Explain when perineal damage may not require a repair

Discuss steps to take if a woman refuses repair

List types of perineal damage which requires referral for

repair

Explain risks of poorly done repair to women's health

Discuss pros and cons of two forms of local anesthetic

¢ Amide vs. ester based

Discuss use of epinephrine in local anesthetic - pro and

con

Explain preferred use of two local anesthetics, including

route of administration

¢ Xylocaine (lidocaine hydrochloride) and Benzocaine
(Cetacaine)

List equipment needed to effect repair of 1¥ degree, 2

degree, and labial lacerations

Explain differences between synthetic and organic suture

Explain differences in needle size and cutting edge and

most appropriate use of each

¢ Taper

¢ Cutting

¢ Taper-cutting

Discuss which instruments are needed for perineal repair,

including sizes and styles of needle holders, clamps,

forceps and scissors

Explain special techniques for working with curved

needles

Demonstrate correct use of needle holder to make an

instrument tie

Demonstrate dual instrument suturing techniques and

other practitioner safety techniques

Discuss pros and cons of hand ties

Demonstrate four basic stitches

¢ Interrupted

¢ Basting

¢ Lock blanket

¢ Running mattress

List steps for 1 degree repair

List steps for 2" degree repair

List steps for labial repair

Explain how to maintain aseptic technique while suturing

Discuss appropriate disposal of repair waste, including

sharps

Discuss pros and cons of subcuticular closure in perineal

repair

NONE

All instructors
must have

training relevant

to course

¢ Licensed

Midwife

¢ Licensed

Physician -
MD, DO,
ND

¢ Physician

Assistant

Healing
Passage: a
Midwife's
Guide to the
Care and
Repair of the
Tissues
Involved in
Birth - 5™
Edition, Anne
Frye

Practical Skills
Guide for
Midwifery - 3"
edition, Pam
Weaver and
Sharon K.
Evans, 2001




DIRECTIONS FOR SCORING CANDIDATES

The candidate's final grades are recorded in the "Examinations” column of the original
transcript. A system for rating candidate performance must be selected by the authorized
provider. Once selected, the system will be utilized to measure all candidates.

The authorized provider has the option of:

1) Developing their own rating system;

2) Using the example shown below; or

3) Granting the full amount of points if the candidate performs with acceptable entry-level
skill and granting no points if the candidate fails to meet that standard. i.e. Issuing a
PASS / NO PASS grade.

The following rating system is offered as a guide to authorized providers in recording and
evaluating candidates' quality of performance:

Excellent 5.0 | Excellent 10.0 | Excellent 15.0 | Excellent 20.0 | Excellent 30.0
Good 45 | Good 8.75 | Good 13.5 | Good 17.5 | Good 26.2
5
Passing 3.75 | Passing 7.5 | Passing 12.0 | Passing 15.0 | Passing 22.5
Below 0 Below 0 Below 0 Below 0 Below 0
Minimum Minimum Minimum Minimum Minimum

Grading Scale:

Points Scored = Grade
95% - 100% =
85% - 94.9% =
75% - 84.9% =
65% - 74.9% =
Below 64.9% =

Candidates must have a minimum of 75 percent to pass each component of the examination.
Any candidate failing to achieve a passing score shall retest at a later date.




EXAMPLE
GRADING FORMS

The following are intended as
guidelines for a
comprehensive written
examination.

10



PHARMACOLOGY

100 possible points (%). Candidate must score a minimum of 75 points (%) to pass course.

Candidate Name: Date:
Candidate Performance Standards Points Points
Possible Awarded
Defining a Drug 5
Distinguishing "Legend Drugs and Devices" from Other Types 5
Defining and Explanation of the Following:
» Action and Effect
» Adverse Reactions
» Agonists and Antagonists 5
» Tolerance
» Interactions
» Placebo Effects
» Compliance
Discussing Various Routes of Administration 5
Explaining Placental Transfer of Medication to the Fetus 5
Explaining How a Drug Moves Through the Body:
» Absorption Rate 5
» Metabolism
» Excretion
Explanation & Discussion of the following:
» Mechanism of Pharmacological Action
» Indications
» Therapeutic Effects 50
» Side Effects / Adverse Reactions
» Contraindications
» Incompatibilities / Drug Interactions
» Administration Including
» Dosage
» Dosage Form & Packaging
» Onset of Action
» Peak Effect
» Duration of Action / Half-Life
Storage and Security 5
Charting the Use of Authorized Legend Drugs and Devices 5
Devising a System for Tracking Legend Drugs and Devices in a
Home-Based Midwifery Practice, Including Expiration Dates 5
Demonstration of resource use - i.e. the Physicians Desk
Reference & Sanford Guide to Anti-microbial Therapy 5
POINTS SCORED 100
TOTAL PERCENT AWARDED 100%

Instructors Initials:
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ADMINISTRATION OF MEDICATIONS THROUGH

INJECTION

100 possible points (%). Candidate must score a minimum of 75 points (%) to pass course.

Candidate Name: Date:
Candidate Performance Standards Points Points
Possible Awarded

Describing & Using Universal Precautions when
Administering Medications, including:

» Gloving

> Eye Protection 30

» Safety Equipment

> Appropriate Disposal of Sharps
Listing Administration Equipment, including:

> Needles - size (length & bore)

> Filter Needles (use with glass ampules) 20

» Syringes - sizes, "lever" locks

» Skin Surface Disinfectants - alcohol, povidone iodine

» Medication Containers (glass ampules, multi-dose

containers, single use vials, etc.)

Differentiation of Medication Administration Sites 15
(subcutaneous, intra-muscular and 1.V.)
Listing Appropriate Sites for Medication Injection 10
Explaining the "Three Point Check" Technique:

> Date on Medication (not expired), type, dosage 10

> Repeat After Drawing up Medication

» Repeat After Administering Medication and Chart
Listing Steps for Administering Drug - IM 5
Listing Steps for Administering Drug - SQ 5
Explaining Appropriate Care of Equipment Used in 5
Administering Medications
POINTS SCORED 100
TOTAL PERCENT AWARDED 100%

Instructors Initials:
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TREATMENT OF SHOCK

100 possible points (%). Candidate must score a minimum of 75 points (%) to pass course.

Candidate Name: Date:
Candidate Performance Standards Points Points
Possible Awarded
Defining Shock 5
Identifying Pathophysiology of Shock 5
Listing and Explaining Four Cellular Phases of Shock 5
Listing Types of Shock 5
Explaining Three Stages of Shock 5
Describing How to Assess a Patient in Shock:
» Defining "Primary Survey" and listing its three components 10
» Defining "Secondary Survey" and listing its two components
Listing Two Steps to Resuscitate a Patient in Shock:
» Basic Life Support: position, warmth, oxygen therapy, CPR 10
» LV. Fluid Therapy
Reasons for Using I.V. Therapy 5
Listing Necessary Equipment for Administration of I.V. 5
Fluids
Explaining Appropriate Care of EQuipment Used in L.V.
Administration 5
Detailing the Appropriate Procedure for Administration of
l.V. Fluids 5
Describing Appropriate Flow Rates for I.V. Administration 5
Identifying S/S of I.V. Failure (infiltration) 5
Listing Dangers of Inappropriately Placed or Maintained I.V. 5
Identifying Appropriate Anti-hemorrhagic Medication 5
Demonstrating Non-Invasive Treatment on Live Model,
including: 5
> Appropriate Positioning for Shock
Demonstrating Appropriate Steps for Administering an 1.V.
on a Mannequin 5
Demonstrating Correct Administration of an I.V. on a Live
Model 5
POINTS SCORED 100
TOTAL PERCENT AWARDED 100%

Instructors Initials:
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MATERNAL AND NEONATAL RESUSCITATION

100 possible points (%). Candidate must score a minimum of 75 points (%) to pass course.

Candidate Name:

Candidate Performance Standards

Points
Possible

Points
Awarded

Knowledge (cognitive):

» Describing the Links in the AHA Chain of Survival, including the

performance of:
Activating the Appropriate Emergency Response System
Performing CPR
Using a Barrier Device
Providing Bag-Mask Ventilation
Providing Early Defibrillation of an Adult
Ensuring the Arrival of Early Advanced Care by Activating the
Appropriate Emergency Response System

Describing the Steps of CPR:

» When to Start CPR

» When to Start Rescue Breathing, including ventilation with a barrier
device and bag-mask (with and without oxygen)

How to Check for Normal Breathing or Signs of Circulation

The ABC Sequence of CPR

When and How to Use an AED on an Adult

The Signs of Severe or Complete FBAO

How to Relieve FBAO in the Responsive and Unresponsive Victim
Describing the Signs of Five Major Emergencies in Adults:

» Heart Attack

» Stroke

» Cardiac Arrest

» Respiratory Arrest

> FBAO
Describing Strategies to Prevent Sudden Infant Death Syndrome in
Infants and Injuries in Children

VVVYVYVY

VVVYVYVYVY

50

Skills (psychomotor):

Activating the Emergency Response System

Rescue Breathing Using Mouth-to-Mouth; Mouth-to-Barrier Device (with

& without oxygen) and Bag-Mask Ventilation with oxygen for Adult,
Infant and Child Victims

1 and 2 Rescuers CPR for Adult, Infant and Child Victims

Using an AED for Victims >/= 8 Years of Age

Relieving of FBAO in the Responsive and Unresponsive Victim of Any

Age

50

POINTS SCORED

100

TOTAL PERCENT AWARDED

100%

Instructors Initials:
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SUTURING

100 possible points (%). Candidate must score a minimum of 75 points (%) to pass course.

Candidate Name: Date:

Candidate Performance Standards

Points
Possible

Points
Awarded

Explaining Basic Female Genital Anatomy

Listing Methods for Preventing Perineal Damage

Defining Degrees of Perineal Damage

Explaining Steps to Evaluate Genitals for Damage Postpartum

Explaining When Perineal Damage may Not Require a Repair

Discussing Steps to Take if a Woman Refuses Repair

Listing Types of Perineal Damage Which Requires Referral for Repair

Explaining Risks of Poorly Done Repair to Women's Health

agljorjorjorjo|ol|o| ol

Discussing Pros & Cons of Two Forms of Local Anesthetic:
» Amide vs. Ester Based

(631

Discussing Pros & Cons of Using Epinephrine in Local Anesthetic

(3]

Explaining Preferred Use of Two Local Anesthetics, including route
of administration:
» Xylocaine (Lidocaine Hydrochloride) and Benzocaine (Cetacaine)

Listing Equipment Needed to Effect Repair of 15 Degree, 2" Degree
and Labial Lacerations

(631

Explaining Differences Between Synthetic and Organic Suture

Explaining Differences in Needle Size and Cutting Edge and Most
Appropriate Use of Each:

» Taper

» Cutting

» Taper-Cutting

Discussing Which Instruments are Needed for Perineal Repair,
including: Sizes, styles of needle holders, clamps, forceps and
scissors

Explaining Special Techniques for Working with Curved Needles

Demonstrating Correct Use of Needle Holder to Make an Instrument
Tie

Discussing Pros & Cons of Hand Ties

w|w

Demonstrating Four Basic Stiches:
> Interrupted
» Basting
» Lock Blanket
» Running Mattress

Listing Steps for 1°' Degree Repair

Listing Steps for 2" Degree Repair

Listing Steps for Labial Repair

Explaining How to Maintain Aseptic Technigue While Suturing

Discussing Appropriate Disposal of Repair Waste, including sharps

Discussing Pros & Cons of Subcuticular Closure in Perineal Repair

NINWWlWw|w

POINTS SCORED

100

TOTAL PERCENT AWARDED

100%

Instructors Initials:
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